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CHAPTER 29 – WEB STUDIO 4.0 SERVICE PACK 3 
ADDENDUM 

Summary of Major New Features 
• Support for Limited Users 
• Create HTML Emails 
• Center Pages in Browsers 
• Center Objects Vertically 
• Attach Files to a Website 
• Change All File Types in a Site 
• Convert Protected Graphics to Normal Graphics 
• And more… 

 

Using Web Studio with Multiple and Limited Users  
 
Web Studio 4.0 has built in support for Windows XP’s Limited Users. Limited Users are those users 
of a computer who do not have the ability to make changes that would harm the computer.  
 
Today, more than eighty percent of computer users at home share their computer with other family 
members. When multiple users share a Windows computer, multiple user accounts can be created 
where each user logs in with his or her own account to access the computer. Normally, these user 
accounts are Limited User accounts that do not have complete control over the system. 
Administrator accounts typically have total and unrestricted access to every part of the computer. 
This can effect how Web Studio and other applications access file and registry information. 

 
Administrators of the system use highly privileged Administrator accounts through which they are 
allowed to make significant changes to the system itself, such as installing and removing key 
software components. And Limited Users have accounts that grant them the ability to run many 
programs on the system, but are restricted from making deep changes. 
 
Windows XP calls these non-administrative accounts Limited. Limited User accounts are used in 
schools, business, and homes. It keeps the kids (and employees) from “messing around” with the 
system and “breaking” it. 
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How to Add a Limited User 
Limited users are added to the computer via the Users Account Control Panel. To add a Limited 
User: 
 

• Click on the Start menu in Windows XP; 
• Choose Control Panels from the Start menu; 
• Double click on the User Accounts icon in the Control Panels window; 
• Click Create a New Account in the User Accounts window; 
• Type in a name for the new user account; 
• Click the Next button; 
• Choose an account type by clicking in the Computer Administrator or Limited radio 

buttons. To create a Limited User account, click the Limited radio button; 
• Click Create Account. 

 
The newly created account will be displayed in the opening Windows screen. Click on the user’s 
icon to log onto the computer with that account. 
 

Initially Running Web Studio as a Limited User  
The first time you run Web Studio as a limited user, the program will create a new Web Studio 
account for you. This may take some time.  What it is doing is copying files from the 
Administrator’s Web Studio and placing them in your account. You don’t need to worry about 
what is happening or what files are being copied. Web Studio knows what to do, and what files 
to let you modify. Just wait for it to complete and the program will start. 
 

Limited User Restrictions 
Web Studio 4.0 Service Pack 3 supports Limited Users. Here is a list of the differences and 
restrictions a Limited User account has with Web Studio. 
 

• They cannot add, delete or otherwise modify content in the Backgrounds, Buttons, 
Dividers, Signs, Clipart, Photos or Templates galleries. 

 
• They can add, delete and modify content in the MultiMedia, Links, and MyStuff galleries. 

 
• They cannot install content using the Insert Menu’s Insert Content from WebStudio.com 

command. 
 

• They cannot save or open Project documents or other files unless they are in their 
MyDocuments folder or in the computer’s Shared Folder. 

 
• The Add This Page to Templates Gallery command in the PageList menu is disabled. 
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• The Gallery’s right click menu is not available for the Backgrounds, Buttons, Dividers, 

Signs, Clipart, Photos or Templates galleries. 
 

• Each Limited user has his own unique MultiMedia, Links, and MyStuff galleries that are 
not available to any other user.  

 
• Each Limited User shares the Backgrounds, Buttons, Dividers, Signs, Clipart, Photos or 

Templates galleries as set up by the computer’s Administrator.  
 

• Each Limited User has his own unique User Dictionary for use with the Spell Checker 
command in the Format menu. 

 

Administrator Actions with Web Studio 4.0 Service Pack 3 
Any user with an Administrator account can act as the Administrator with Web Studio. Here are 
the things specific to Web Studio that the Administrator can do: 
 

• The Administrator can install, modify, repair, and uninstall Web Studio and Web Studio 
Upgrades. 

 
• He can add, delete or otherwise modify content in the Backgrounds, Buttons, Signs, 

Clipart, Photos or Templates galleries. These changes will be seen and be available to all 
users of Web Studio on the computer including both Limited and Administrator users. 

 
• The Administrator can add or delete Templates to the Templates Gallery. 

 
• In short, the Administrator can do all of the things that the Limited user cannot do, as 

previously described. 
 

Creating HTML Emails with Web Studio 4.0  
 
Everyone has seen HTLM emails. The monthly Web Studio Newsletter is an HTML email. Most 
emails that are advertisements are sent as HTML email. Sending email as an HTML email enables 
you to design a visually appealing email instead of just a bunch of boring text. 
 

How Do I Create an HTML EMail 
To create one you simply design a web page in Web Studio and then choose the Save Page as 
HTML Email from the Page menu. The page you create becomes the email, simple! 
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What can I put in an HTML Email 
You can add anything you want to an HTML Email you create with Web Studio. You can add text, 
links, graphics, movies, music, Flash, downloadable files, rollover buttons, anything! 
 

What Restrictions do HTML Emails Have 
The only restriction is that an HTML Email has to be one page. However, there are some practical 
restrictions, like the width of the page and the size of all the files.  
 
The reason the page width is a “restriction” is because most emails are viewed at the default 
width of the email program used to view it in. Open an email in your email program and see how 
wide it is. You can also look at the Web Studio Newsletters, their width is around 760 pixels. We 
do this to keep it smaller than an 800 pixel wide monitor. 
 
The reason the size of the files matters, is that the person who receives the email will have to 
wait for all of the files to download from your website. So, treat the emails the same as you 
would your website’s pages, keep them below 100k. Note that you can check the combined size 
of the files by choosing Size & Download Time from the Page Properties dialog in the Page menu. 
 

What Can I Use HTML Emails For 
You can use them to “spruce” up your normal emails. You can use them as advertisements. You 
can create a monthly newsletter. You can use them to quickly send pictures of the kids to 
relatives. You can use them to quickly send pictures and descriptions of your products to 
customers. You can use existing pages on your website as HTML Emails by simply saving a page 
from your site as an HTML Email and then sending it to whomever.  
 

How do I Create an HTML Email in Web Studio 
 
First you should have an idea of what Web Studio does to create the HTML Email for you. First, 
the HTML Email is nothing more than a webpage that is sent via email. When you create your 
website with Web Studio, you have to Upload it to your hosting company for people to see it on 
the web. You also have to upload the HTML Email’s files to your hosting company. The big 
difference between your site and the email is that you don’t send the actual HTML files to the 
hosting company, just the other files; like graphics, MP3 files, videos, etc. The HTML file doesn’t 
need to be uploaded. Why? Because you are sending the HTML directly to the email recipient!  
 
What all of this means is that it is a multi-step process to create your HTML Email in Web Studio. 
However, you will see these steps are baby-steps, not giant-steps. 
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Here are the steps to create your HTML Email 
 

• Create a page in Web Studio, add whatever you want to it. 
• Choose Save Page as an HTML Email from the Page menu. 
• Enter the complete URL to your home page. 
• Save the HTML file to your hard drive. This file is the one you actually use in your email. 
• Upload your page to your site. 
• Open the HTML file and add the contents to your email program.  
• Send the email. 

 
Web Studio automates every step except adding the HTML to your email. 
 

• Once you choose Save Page as an HTML Email you’ll be prompted by Web Studio for the 
URL to your website. This is what you’d type to get to your home page. For us, it would 
be http://www.webstudio.com  

 
• You next be prompted to enter the location to save the HTML file, just put it in a folder in 

your MyDocuments folder.  
 

• It will then bring up the Web Studio or iHostStudio Publisher wizard to upload your page. 
Just upload it as normal. 

 
• That is the end of creating the email. 

 
• Now you just open the file you saved in Notepad and copy and paste the HTML into your 

email, or you follow your email programs’ instructions for creating an HTML email.  
For our monthly Newsletter: 

• We just create the new newsletter; 
• choose Save Page as an HTML Email; 
• Enter http://www.webstudio.com; 
• Enter the name for the HTML file, usually something like Vol4No2; 
• Click Upload in the Web Studio Publisher; 
• Then go to our bulk-email program and tell it to use the Vol4No2 file as the mail.  
• Then we press the Send button. 

 

Some Hints on Using the Save Page as HTML Email Feature 
Create one project that you keep all of your newsletters in. You name the project “Newsletters” 
and then create your first newsletter as the first page of the project. Once you’ve completed it, 
save it as an HTML Email and send it out.  



Web Studio 4.0  Web Studio Service Pack 3 Addendum 

 
Page 6 

 
Next time you need to create a newsletter, just open the project and duplicate the first page. Edit 
this new page to create your new newsletter. Rename the page and then save it as an HTML 
Email. This way you have all of your newsletters in one project, have immediate access to them 
for editing, simplify the creation of new ones via the duplicate command. 
 
Use existing pages in your web site to send to customers as an email. Just open your website’s 
project file, go to the page you want to send to the customer and save it as an HTML Email. 
 
Create a project that has the answers to various frequently asked customer support questions. 
Remember, you can add multimedia to your emails now, so you can create movies, animations, 
flash animations to illustrate the answer to the question. 
 
If you re-use a page as an HTML Email, as suggested above, you may not have to re-upload 
every time you send it out as an email, just click Cancel when the WebStudio or iHostStudio 
Publisher wizards appear. The reason you don’t have to upload is because you already did, the 
last time you sent it. You can make changes to text and the location of objects and not have to 
re-upload. Note, however, that if you make any changes like bring to front or send to back, or 
add additional objects to the page you should definitely re-upload the page, if you don’t it won’t 
look right as an email. 
 
Send the email you’ve created to yourself to check it to make sure it is the way you want it. You 
should do this every time you create an HTML Email! 
 

Centering Pages in Browsers 
 
Many people have asked for a way to center their pages in the browser, no matter what size the 
browser window is. This is because a site designed to fit in a smaller window would have the 
site’s pages on the left side of the browser with blank space on the right side. Turning on this 
feature will center the pages in the website in the browser window. Note that this sites that use 
Frames will not be centered. 
 
To center the pages of your site: 

• Choose Website Properties from the Web Site menu. 
• Click the Advanced Tab in the dialog. 
• Click the Center Pages in Browser check box to put a check in the box. 
• Click OK. 
• Choose Preview Website from the Preview menu to view your pages centered in the 

Preview window’s browser. 
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Centering Object Vertically 
 
Web Studio has been able to center objects horizontally for quite a while. It can now center them 
vertically. This comes in handy, for example, when you want to center a graphic and some text 
that are beside each other.  
 

• To center objects vertically: 
• Select the first object as the basis for the centering; 
• Select another object by holding down the shift key and clicking on it; 
• Select any additional objects in the same fashion. 
• Choose Center Selected Objects Vertically from the Objects menu or Click the Center 

Selected Objects Vertically button in the Layout Toolbar. 
 
The Objects will center themselves relative to the first object selected. 
 

Attaching Files to a Website 
 
Web Studio can now automatically upload any file(s) you want along with your website. This 
comes in handy when you are using other programs with Web Studio, for example a pop up 
menu program. These programs typically require you to upload some number of JavaScript files 
and other files in order for the menus to work.  Previously, you would have to upload these files 
via a separate FTP program, or add them to an HTML object on a page and then link the menus 
to that page.  This made for a cumbersome and confusing task of adding the menus. 
 
With Service Pack 3, you can simply go to the Website Properties dialog, in the Website menu, 
click on the Attached Files tab and add any files you need. The files will be uploaded when you 
upload your site or a page. They will be uploaded in the same location (or folder) as the HTML 
files in your site.  
 
Attaching Files to a Web Site 

• To attach files to a website: 
• Choose Website Properties from the Website menu. 
• Click on the Attached Files tab. 
• Click on the Add Files to List button, the Windows Open dialog comes up. 
• Choose the files to be added to the website. You can hold down the Shift key to select 

multiple files or hold down the CTRL key to select multiple files that are dis-continuous. 
• Press Open when the files have been selected. 
• You can attach additional files from other locations by repeating this procedure. 
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• You can Delete any attached files by selecting them in the Attach Files tab and clicking 
the Delete button. Note that this does not delete the actual file, it just removes it from 
the lists of attached files for this website. 

• You can use the Verify button to have Web Studio check to see if the attached files are 
still available in the same location on your computer. 

Linking to Attached Files from within Web Studio or other programs 
Any files attached to a site are uploaded into the site folder along with all of the site’s 
HTML files. This means any links to an attached file can simply be the file’s name. For 
example, if a file were named “Menus.js”, any HTML or Javascript or Link that referenced 
that file would simply use “Menus.js” as the link. Simple!  
 

Changing Files Types for All Files in a Site 
 
Web Studio 4.0 added the ability to specify what file type you wanted to build on a page-by-page 
basis. This feature enables you to change every page’s file type for both “on the web” and for 
“preview”. 
 
To change the type of files for all pages: 

• Go to the Web Site menu; 
• Choose Website Properties; 
• Click on the File Types tab; 
• Choose the file type for Pages on the Web from the popup menu. 
• Choose the file type for pages that are Previewed from the popup menu. 
• Click OK. 

 
Web Studio will then go through your pages and change their file types. 
 

Converting Protected Graphics to Normal Graphics 
 

Sometimes it is desirable to convert a Protected Graphic object to a normal 
graphic. Service Pack 3 adds a “hot-key” feature that will do this for you. You can 
convert a single protected graphic or a series of protected graphics all at once. 
 
Converting a Protected Graphic to a Normal Graphic 
 

• Click on the Protected Graphic to be converted. 
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• Press and hold down the “g” key on the keyboard. 
• Click on the Protected Graphic to be converted. 

 
A new, normal, graphic will be created and placed on the page to the right and below the original 
protected graphic. 
If you wish to delete the original protected graphic, press the Delete key or choose Clear from the 
Edit menu. 
 
Converting a series of Protected Graphics to Normal Graphics 

• first Protected Graphic to be converted. 
• Press and hold down the Shift key and click on the remaining graphics to be converted 

while holding down the Shift key. 
• Once all of the graphics have been selected, release the Shift key. 
• Press and hold down the “g” key on the keyboard. 
• Click on any of the Protected Graphics to be changed. 

 
A new, normal, graphic will be created and placed on the page to the right and below each of the 
original protected graphics. 
If you wish to delete the original protected graphics, press the Delete key or choose Clear from the 
Edit menu. 
 
Converting all of the Protected Graphics on a Page to Normal Graphics 
 

• Choose Select All from the Edit menu. 
• Press and hold down the “g” key on the keyboard. 
• Click on any of the Protected Graphics to be converted. 

 
A new, normal, graphic will be created and placed on the page to the right and below each of the 
original protected graphics. 
If you wish to delete the original protected graphics, press the Delete key or choose Clear from the 
Edit menu. 
 

Other New Features and Enhancements 
• Help with Lost Project Files: When Web Studio can’t find the Project file you are 

attempting to open, it will give an error dialog telling the name of the file, its last known 
location, and steps to take to locate the file. 

 
• Previewed Pages use .HTML: For new pages, the default file type for Previewed 

pages is now .html instead of .htm.  
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• Moving Text in Netscape: The Netscape Text Fix has been removed from the Website 
Properties dialog’s Advanced Tab. It is no longer necessary since Web Studio now adds 
appropriate HTML to solve the problem automatically. This fix keeps text from moving in 
the Netscape family of browsers. These include Netscape Navigator,  FireFox, Mozilla. 

 
• Non-WebSafe Fonts Turned to Graphics: For new websites, text objects containing 

fonts that are color-coded yellow are converted to graphics by default. This can be 
changed in the Website Properties dialog’s Advanced Tab, and existing websites can be 
set to do this the same way.  

 
• Enhanced Video Choice Dialog: The Video Choice dialog disables some properties 

that aren’t available with Quicktime movies. 
 

• Page Guide Settings Saved: The on/off status of Page Guides is saved with the 
Project and with pages now. 

 
• Page Design Size Saved: The Page Design Size is now saved with the Project. 

 
• Home Page Name Help: Pages cannot be named “index.html” or “index.htm” or 

“index” anymore. To designate which page’s HTML file should be named “index”, place 
the House Icon next to your home page’s name in the PageList. Do this by right clicking 
on the page’s name in the PageList and choosing HomePage. Note that if your existing 
site has a home page named “index”, it will not be affected by these changes. Only 
pages that you attempt to rename will be subject to the new rules. If yours is named 
“index” you should rename it with a name that reflects your websites function, like your 
company name or product name. 

 
• Illegal Characters in Page Names Excluded: You cannot enter a period, a single 

quote or a double quote in a page name now. This would cause problems with links and 
javascript. Note that your existing site will not be affected by these changes. Only pages 
that you attempt to rename will be subject to the new rules. 

 
• Enhanced HTML Object: The HTML object now remembers its “Build with/without 

Tags” option settings. 
 

• Time Zone Change: The HTML Source of your site’s pages will show the file’s creation 
time as Pacific Standard Time. This is to help tech support. 

 
• Help Changing Home Pages: A dialog is displayed asking for confirmation when you 

choose to change your Home Page. 
 

• Add Anchor to Object Enhancement: The Program Preferences dialog in the Edit 
menu now contains a check box to add the “Add Anchor to Object” command to the 
Links gallery. Some Windows systems delete the first item in the gallery, this preference 
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forces Windows to put it there. If you already have “Add Anchor to Object” in the Links 
gallery, leave this unchecked. 

 
• Protected Graphics Enhancement: The “Place holder” graphic is now being 

resampled to  makes its memory requirements minimal. 
 

• The Title Tag in a page’s HTML is now the first tag in the HTML. 
 

• Spelling checker in the Format menu works fine. 
 

• The Download Time/Size page in the Page Properties dialog gives accurate results 
again. 

 
• Saving a Project with the Preview window open doesn’t delete text. 

 
• Adding templates to the Templates gallery works. 

 
• Real Video and Quicktime Video work better now. 

 
• The colors of Text Links weren’t displayed in Firefox, Mozilla, or Netscape. They are now. 
• A text object with the text file:/// in it won’t cause problems now. 

 
• Objects that had a zero height or width could cause a “failure to build image table 

error”. Web Studio now deletes these objects when a page is opened. 
 

• On occasion, the formatting of text would be “lost” when previewed or uploaded. 
Formatting isn’t lost anymore. 

 
• Multimedia files, except for Flash files, were getting uploaded twice. Now they get 

uploaded only once. 
 

• Protected Graphics that were moved and then located again during a Preview This Page 
had their new locations remembered. However, if they were located during a Preview 
Web Site, their new locations were not remembered. Now they are. 

 


